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Welcome to the online Parent/Teacher Conference Reservation System from Virtual Paragon.  
We hope that this System will make it easier and more convenient for you to sign up for 
conferences  with  your  children’s  teachers. 
Before you begin, please make sure you have a recent version of your browser.  (We recommend 
Mozilla Firefox 17.0 or higher, or Microsoft Internet Explorer 9.0 or higher.  Upgrades are available from 
http://www.getfirefox.com/ and http://www.microsoft.com/ie/, respectively.) 
 
Here is the information you should have ready: 
x You need to have a list of all the teachers you would like to see.  The System will not tell you 

the names  of  your  children’s  teachers. 

x You should think about what times you would like to have conferences.  The System will tell 
you  the  teachers’  available  slots,  but it will help to think about your own availability ahead of 
time. 
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OVERVIEW 
Here’s  what  you’ll  have  to  do,  in  a  nutshell.    More  detailed  instructions  are  available  below. 
x Go to the Parent/Teacher Conference Reservation System web site.  You can get there from 

the  school’s  web  site.    You  will  have  to  enter  your  school’s  master  password. 
x Create your own account account if  you  don’t  already  have  one  (e.g.,  from  a  previous  set  of 

conferences).  This involves choosing a user name and password. 
x Log in to the System.  This involves typing in your user name and password, which will 

bring you to the Main Menu. 

x Select the activity you want to do, such as making reservations.  
x Select the teachers you want to sign up for.  This involves clicking in the box by each 

teacher’s  name. 
x The schedules of teachers you have selected will be displayed, next to each other.  You can 

scroll side to side to see the different teachers.  You can scroll up and down to see the 
different time slots and days. 

x Reserve the slots you need.  This involves clicking in the available time slots. 
x Press SAVE to reserve the slots you have selected so far, or press SAVE/DONE when you 

have finished making all your reservations. 
x Check the list of your reservations.  If you are satisfied you can print your reservations, or 

you can go back and make changes. 
x Don’t  forget  to  log  out  of  the  System when you are done. 
 
Remember: 
Your selected conference time slots are not really yours until you press the SAVE or 
SAVE/DONE button and see that your requested slots have been reserved for you.  If you have 
selected a conference time slot, but have not yet saved your reservation, someone else may be 
signing up for the same slot at the same time.  Whoever saves first gets the slot. 
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TECHNICAL SUPPORT 
The school will try to have someone available to answer questions or resolve any problems you 
may have with this System.  You may also have received a letter with names and phone numbers 
of people you can call for assistance.  You can also send a question by e-mail to the school’s  
support e-mail address shown on the Welcome page. 
 
Always consult this User Guide (especially the Frequently Asked Questions (FAQs) list at the 
end) before contacting the school for technical support. 
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DETAILED INSTRUCTIONS 
This section contains detailed instructions for each of the tasks in the System that you can 
perform. 
 
Go to the web site 
1. Open your Internet browser. We recommend Mozilla Firefox 17.0 or higher, or Microsoft 

Internet Explorer 9.0 or higher.  Upgrades are available from http://www.getfirefox.com/ and 
http://www.microsoft.com/ie/, respectively. 

2. Go to the Parent/Teacher Conference Reservation System. You can get there from the 
school’s  web  site. 

3. On  the  front  page,  provide  your  school’s  master  Password  and  press  the  button  that  says  
“Click  to  Enter.”    The  school  should have provided this master Password to you, and it is not 
the same as your own account credentials (if you already have an account). 

4. After  you  successfully  enter  your  school’s  master  Password,  the  Welcome  page  will  appear. 
 
Create your account 
The first time you visit the System, you will have to create your account.    Here’s  what  you  do: 
1. On  the  Welcome  page,  press  “Create  New  User  Name.” 
2. Enter your full name and email address in the provided spaces. 
3. The System will automatically use the first initial and last name you entered as your user 

name.    If  you  don’t  like  this  name,  you  can  change  it  by  typing  something  else  in  the  user  
name space. 

4. Enter a password that you would like to use for this System. It will not appear on the screen 
as you type it.   
Note:  A password should be at least 5 characters long.  Capitals make a difference.  This 
means  that  “Secret”  “secret”  and  “SECRET”  are  all  different  passwords.    A  password  should  
be easy for you to remember, but hard for others to figure out. 

5. Enter the password again, in the next space. 
6. Enter a hint for your password.  This way, if you forget your password, you can ask for your 

hint and we can send you an email reminding you.  For example, if your password was 
“sparky,”  your  hint  might  be  “My  second  dog.” 

7. If you want to allow your school to also send you school e-mail that may not be conference-
related,  select  “Yes”  for  “Opt-In School E-mail”.1 

                                                 
1 Some schools do not enable this option. 

http://www.getfirefox.com/
http://www.microsoft.com/ie/
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8. If you want to keep this account for future conference sessions and expect that you will 
remember your user name and password,  select  “Yes”  for  “Keep  My  Account”.2 

9. Press  “Create  my  Account.”  (Or,  if  you  want  to  start  over  with  this  page,  press  “Clear  form.”    
Or,  if  you  want  to  exit  the  System,  press  “Cancel.”) 

10. If  you  pressed  “Create  my  Account,”  the  System  will  create  your  account, and will bring you 
to a page confirming that an account was created for you with your user name.  Your 
password will not appear, now, or any time you type it.  It will remain private. 

11. You can now log into the System from this page, by pressing Login. 
 
Log in to the System 
Before you use the System, you will have to log in.  You have to log in every time you visit the 
System.    Here’s  what  you  do: 
1. On  the  Welcome  page,  press  “Login.”    If  this  is  your  first  time  visiting  the  System,  go  back  

to Create your account. 
2. Enter  your  user  name  and  password,  and  press  “Login.”    You  will  be  brought  to  the  Main  

Menu.  Your name will be displayed at the top.  If your name is incorrect then you may be 
using the wrong user name, and you should not make reservations until it is corrected.  If this 
occurs, please send e-mail to the support  address  indicated  and  then  press  the  word  “logout”  
in  the  yellow  “Caution”  box. 

3. Don’t  forget  to  log  out  when  you  are  finished  using  the  System. 
 
Make reservations for conferences 
You are now ready to sign up for your conferences.  By the way, the wider you make your 
browser  window,  the  more  teachers’  schedules  you  will  be  able  to  see  at  once  – so you may want 
to maximize your browser window if you haven’t  already  done  so. 
Here’s  what  you  do  to  sign  up  for  conferences: 
1. On  the  Main  Menu,  press  “Make  reservation(s).” 
2. You  will  be  brought  to  the  page  displaying  all  the  teachers’  names.    The  teachers’  names  are  

arranged alphabetically.  If your school has grouped teachers into categories, you can choose 
to  view  the  list  of  teachers  using  these  groupings  by  pressing  on  the  “[List  Teachers  By:]  
Category”  button  at  the  top. 

3. Go to the teacher you want to select.  You may do this by scrolling up or down.  You may 
also  press  the  first  letter  of  the  teacher’s  last  name  from  the  “Shortcuts”  alphabet  display  at  
the  top  of  the  page  to  go  directly  to  that  letter.    (To  jump  to  the  top,  press  “Top”  which  is  
displayed at the end of each letter grouping. 

4. Click in the box next  to  the  teacher’s  name  so  that  the  checkbox  appears  chosen. 

                                                 
2 Some schools do not enable this option. 
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5. Repeat steps 3 and 4 for all the teachers you want to see.  You may select as many teachers 
as you want. 
On  the  next  display  page,  all  the  selected  teachers’  schedules  will  be  displayed  at  once.  You 
will scroll from side to side to see them. 

6. Go  to  the  bottom  of  the  page  and  press  “Continue.”  (To  jump  to  the  bottom,  press  “Bottom”  
which is displayed at the end of each letter grouping.)  (Or, to return to the Main Menu, press 
“Cancel.”) 

7. You will be brought to the page displaying the schedules of the teachers you selected. 
The schedules of all the teachers you selected are displayed on the left side of the page.  You 
can scroll from side to side to see all of the teachers, and up and down to see the whole 
schedule.  Their schedules scroll together, to help you see all the time slots in the right order. 
Your reservations will be displayed on the right side of the page.  Teachers you selected on 
the previous page but with whom you have not yet requested time slots are shown under a 
“To  Do”  list. 
Remember, not all time slots are of equal length (e.g., some teachers may have 10 minute 
time slots, some may have 5 minute time slots, etc.).  Slots that are available are displayed in 
green.  Slots that are not available (already reserved, or not available for other reasons) are 
displayed in gray.  Slots that you have already reserved (perhaps in a previous session) are 
displayed in white. 

8. Click  in  the  box  of  any  slot  you’d  like  to  reserve  to  make  the  checkbox appear chosen.  As 
you  make  time  slot  selections,  teachers  will  move  from  the  “To  Do”  list  on  the  right  to  the  
“New  Requests”  list.   
If you request more than one slot for the same time of day, you will receive a warning 
message.  If you intended to do that (perhaps you and your spouse are each visiting a 
different  teacher  at  the  same  time),  press  “OK.”    If  it  was  a  mistake,  press  “Cancel.” 
If you request more than one slot for the same teacher, you will receive a warning message.  
If you intended to do that (perhaps you have two children that both have the same teacher), 
press  “OK.”    If  it  was  a  mistake,  press  “Cancel.” 
NOTE:  Requested  time  slots  are  not  yours  until  you  Save  and  see  them  appear  in  the  “Your  
Reservations”  list  on  the  right. 

9. When you are sure about your selections press “Save”  or  “Save/Done.”    You  can  press  
“Save”  at  any  time,  and  still  go  on  to  make  more  reservations. 
Your  selected  conference  time  slots  are  not  really  yours  until  you  press  the  “Save” (or 
“Save/Done”) button and see those slots  move  from  the  “New  Requests”  list  on  the  right  to  
the  “Your  Reservations”  list.    If  you  have  selected  a  conference  time  slot,  but  have  not  yet  
saved your reservation, someone else may be signing up for the same slot at the same time.  
The first person to press Save gets the slot. 

10. If  you  want  to  remove  a  time  slot  that  you  have  checked  off  (requested)  but  haven’t  saved  
yet, you can go back to that slot, and click the check mark that appears.  The check mark will 
disappear.  If you want to remove a reservation that you have already saved, you can uncheck 
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the box by that reservation in the same way, but your reservation is not actually released until 
you Save this change. 

11. If you want to start over and erase ALL time slots you have checked off (requested) but 
haven’t  saved  yet,  press  “Revert.”    This  means  you  will  Revert  to  Saved,  or  go  back  to  the  
way things were the last time you pressed Save. 

12. Any  time  you  want  to  go  back  to  the  Main  Menu  without  saving,  press  “Cancel.”    Time  slots  
you have requested but haven’t  saved  will  be  lost. 

13. When  you  have  finished  making  all  of  your  reservations,  press  “Save/Done.”    This  will  take  
you to an Edit Reservations page that reviews all your reservations and allows you to 
continue changing them. 

 
Request that a teacher call you 3 
If  you  couldn’t  get  a  time  slot  with  a  teacher,  you  may  leave  them  a  message  to  call  you.    Here’s  
what you do: 
1. On  the  Main  Menu  or  at  the  bottom  of  the  Add  Reservations  page,  press  “Request  a  teacher  

to call  me.”  You  will  be  brought  to  the  page  titled  “Call  back  request.” 
2. Select  a  teacher  from  the  scrolling  list  by  clicking  on  the  teacher’s  name. 
3. Enter your phone number. 
4. Enter any comments, such as the best time to reach you. 
5. Press  “Save.”  (Or,  if  you  want  to  start  over  with  this  page,  press  “Clear.”    Or,  if  you  want  to  

return  to  the  Main  Menu  without  saving,  press  “Main Menu.”) 
 
View reservations that you have already made 
You  may  want  to  look  at  a  summary  of  reservations  that  you  have  already  made.    Here’s  what 
you do: 
1. On  the  Main  Menu,  press  “View  my  current  reservation(s).”     
2. You  will  be  brought  to  the  page  titled  “Reservations  Summary  for  <your  name>.” 
3. Your reservations will be displayed on this page. 
4. You may print this page for your own records (see Print Your Reservations below). 
 
Delete reservations or call back requests you have already made   
Perhaps  you  need  to  change  a  reservation  that  you  have  already  saved.    Here’s  what  you  do: 
1. On the Main Menu, press “Delete  some  or  all  of  my  reservations.”    (If  you  have  call  back  

requests,  this  will  say  “Delete  some  or  all  of  my  reservations  or  call  back  requests.”) 

                                                 
3 Some schools do not enable this option. 



Parent/Teacher Conference Reservation System User Guide 

Page 8  Copyright © 2002,2013 by Doron Shalmon 
  All Rights Reserved 

2. You  will  be  brought  to  the  page  titled  “Edit  Reservations  for  <your  name>.”    (You  will  also  
arrive at this page when you press Done after making your reservations.) 

3. Press the Delete button next to a reservation (or call back request) you want to delete. 
4. You will be asked to confirm that you want to delete the reservation (or call back request). 

To delete it,  press  “OK.”    If  it  was  a  mistake,  press  “Cancel.” 
5. Your selected reservation (or call back request) will be deleted, and you will return to the 

page displaying your remaining reservations. 
6. Repeat this process (from Step 3) for any other reservations (or call back requests) that you 

want to delete. 
 
Note:  From the Edit Reservations page, you can get to any of the activities of the System, 
including adding more reservations, deleting, and requesting that a teacher call you.  You do not 
have to go back to the Main Menu.  
 
Print your reservations 
If you have access to a printer, you will probably want to print a record of your reservations.  
Here’s  what  you  do: 
1. On  the  Main  Menu,  press  “View  my  current  reservation(s)”,  or  on  the  Edit  Reservations  

page,  press  “View a print-friendly  version  of  this  page.” 
2. You will be brought to a page that is formatted especially for printing.  
3. Press  “Print”  or  choose  Print  from  your  browser’s  File  menu. 

If  you  are  using  a  Netscape  browser  and  the  “Print”  choice  is  not  enabled  (it appears gray and 
cannot be selected), you must first click on a white area in the center of the page before 
pressing Print. 

 
Download your reservations to your calendar 
If you use calendar software on your computer (e.g., Outlook, Apple iCal, etc.) you can 
download your conference reservations schedule to your calendar, and then optionally sync it to 
your  PDA  or  smart  phone.    Here’s  what  you  do: 
1. On  the  Main  Menu,  press  “View  my  current  reservation(s).” 
2. You will be brought to the page that displays your conference reservations. 
3. Press  “Download  to  your  calendar…”. 
4. In the options box that pops up, choose the format that is supported by your calendar 

software – iCalendar is supported by most (including Outlook and Apple iCal), but 
vCalendar and CSV for Outlook are also available.  Then  press  “Download.” 

5. When prompted whether you want to Open or Save the exported file, choose Save to save the 
file onto your computer.  Some calendar applications (e.g., Outlook) will only import the first 
conference reservation if you choose Open. 
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6. Open your calendar software and import the file that you saved.  The steps required will 
depend on the calendar software you use and the format you selected. 

7. Sync with your mobile device as usual. 
 
Log out of the System 
When you are finished using the Parent/Teacher Conference Reservation System you should log 
out.    Here’s  what  you  do: 
1. Be sure you have saved everything that you want to save, and printed everything that you 

want to print. 
2. Press the Logout button at the top right of the window. (Or, if you are on the Main Menu, 

select the Logout option from the list of things you can do.) 
3. You will be asked whether you are sure you want to log out of the System, in case you 

pressed the button by accident.  If you are sure, press the OK button in the message box.  
Remember, you can always come back to the System again. 

4. You will be returned to the Welcome page.  From there, you can log in to the System again, 
or  you  can  return  to  the  school’s  home  page. 
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FREQUENTLY ASKED QUESTIONS (FAQS) 
Here are some typical questions, and their answers.  You should consult this list if you have a 
question, before you phone a friend or contact support. 
 
1. How do I get to the Parent/Teacher Conference Reservation System? 

Answer:  Go  to  the  school’s  web  site.    There  you should find a link or button that will take 
you to the Parent/Teacher Conference Reservation System. 

 
2. I am having trouble getting online (constant busy signal, no answer). 

Answer:  Contact your Internet Service Provider for assistance. 
 
3. Do I have the correct Internet browser? 

Answer:  Choose "About..." from the Help menu in your browser to find out what version of 
the browser you are using.  We recommend Mozilla Firefox 17.0 or higher, or Microsoft 
Internet Explorer 9.0 or higher.  Upgrades are available from http://www.getfirefox.com/ and 
http://www.microsoft.com/ie/, respectively. 

 
4. I forgot my login name.  What do I do? 

Answer:  On the Login page, click on the box next  to  “I  forgot  my  user  name”,  enter  your e-
mail address, and then click the Request User Name button.  If an account with your e-mail 
address is found, the System will automatically send your user name and password hint to 
that e-mail address. 
If you did not provide an e-mail address when you created your account, you can send an e-
mail to your  school’s  support e-mail address as indicated on the Welcome page and include 
your full name as you entered it when you created your account. We will attempt to 
determine what user name you specified and send it to you by e-mail. 

 
5. I forgot my password.  What do I do? 

Answer: On the Login page, enter your User Name, click on the box next to "I forgot my 
password" and then click the Request Hint button.  If you provided us with your e-mail 
address and a password hint when you created your account, the System will automatically 
send your hint to your e-mail address. 
If your  password  hint  doesn’t  help,  you  can  once  again  click  on  the  box  next  to  "I  forgot  my  
password" but this time click the Reset Password button. 

 

http://www.getfirefox.com/
http://www.microsoft.com/ie/
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6. Can I make changes after saving my reservations? 
Answer:  Yes.  When you Save your reservations, you will see a summary of all the 
reservations you have made.  At the bottom of that page you can click on "Add more 
reservations"  if  you  want  additional  reservations.    You  can  also  click  “Delete”  next  to  any  
reservations you want to delete. 

 
7. What if two (or more) people hit Save at the same time? 

Answer:  The first person to save a reservation gets that time slot, even if they were first by 
only a split second.  Other people who try to save that same slot will not see the slot appear 
on  their  “Your  Reservations”  list  and  may  see  a  message  explaining  that  some  of  their  
requested slots were not saved, possibly because someone else got it first. 

 
8. My computer crashed in the middle of doing this.  What do I need to do? 

Answer:  Restart your computer, return to the Conference System and login again.  Choose 
“View  my  current  reservations”  to  see  how  far  you  got.  You  may  then go back to add more 
reservations, delete reservations, or do any other necessary activities. 

 
9. I think I did the program correctly, but I'm not sure.  How can I check? 

Answer:  Choose  “View  my  current  reservations.”  You  may  then  go  back  to  add  more  
reservations, delete reservations, or do any other necessary activities. 

 
10. Can I print out my reservations? 

Answer:  Yes, we recommend that you do this, for your records.  Go to the Main Menu and 
press  “View  my  current  reservation(s)”,  or  from  the  Edit  Reservations  page,  press  “View  a  
print-friendly  version  of  this  page.”  Press Print or choose Print from the File menu. 
If you provided us with your e-mail address when you created your account, the school may 
send you an e-mail after the signup period is over with a summary of your reservations and 
you can also print out this e-mail. 

 
11. I want to print out my reservations but the Print button and menu item are disabled (grayed 

out).  What should I do? 
Answer:  If  you  are  using  a  Netscape  browser  and  the  “Print”  choice  is not enabled (it 
appears gray and cannot be selected), you must first click on a white area in the center of the 
page before pressing Print.  

 
12. When  I  print  out  my  reservations  it  doesn’t  seem  to  fit  across  the  page.    What  should  I  do? 

Answer:  The width of your reservation summary will depend on several things, including 
the  length  of  the  teachers’  names  and  the  font  size  (the  size  of  the  text).  Make sure you are 
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printing  the  “print-friendly”  view  that  does  not  have  the  Delete  buttons  next  to  each  time  slot, 
as this may free up some horizontal space on the printed paper.  In addition, you have several 
options: 

a. Change  your  browser’s  print  orientation  from  Portrait  to  Landscape.    For  example,  in  
Internet Explorer, choose File  >  Page  Setup…  and then click on Landscape in the 
Orientation box. 

b. If  that  still  doesn’t  give  you  enough  room,  change  your  browser  to  use  a  smaller  text  
font size before printing.  For example, in Internet Explorer, choose View > Text Size 
and then click on either Smaller or Smallest. 

c. Finally,  if  all  else  fails,  change  your  browser’s  Page  Setup  to  use  smaller  left  and  
right margins when printing.  For example, in Internet Explorer, choose File > Page 
Setup…  and  change  the  values  for  Left  and  Right  in  the  Margins  box  to  be  0.25”  
(one quarter of an inch). 

 
13. The conference sign-up period is over but the conferences haven't happened yet, so I still 

might want to see my schedule.  Can I still view my reservations?  Can I still print them? 
Answer:  Yes.  Once the signup period is over, you will no longer be able to make 
modifications but you can still login to view your reservations. You should make sure to print 
a copy of your schedule (or write it down somewhere if you don't have access to a printer). 
Note also that if you provided your e-mail address when you created your account, the school 
may send you an e-mail after the signup period is over with a summary of your reservations.  
If  you  didn’t  print  a  copy  of  your  schedule  before,  you  should  make  sure  to  print  out  this  e-
mail. 
 

14. The conference sign-up period is over and I need to make a change to my reservations.  What 
should I do? 
Answer:  Once the signup period is over, you will no longer be able to make modifications 
to your reservations.  Contact your school office to find out if there is still time for them to 
make adjustments on your behalf. 
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COPYRIGHT, USAGE TERMS AND CONDITIONS 
The Parent/Teacher Conference Reservation System is 
Copyright © 2002,2013 by Doron Shalmon. 
All Rights Reserved. 
 
By installing, downloading, or otherwise using any portion of this Software or Documentation, you accept and agree to be bound 
by all the terms and conditions listed below. 

License  
The software product identified above, including but not limited to any software, media, and accompanying on-line or printed 
documentation (collectively "Software") is licensed, not sold, by Virtual Paragon LLC ("Licensor") to the School.  

For information about licensing this Software for another school, contact Virtual Paragon at sales@VirtualParagon.com. 

Permitted Use  
Any staff member of the licensed School or parent with a child currently attending the licensed School is hereby authorized to 
use the Web portion of the Software ("Web Software") for the purposes of scheduling parent/teacher conferences only. 
Redistributing, selling, copying, or reproducing any part of the Software over any medium without prior written consent from 
Licensor is expressly forbidden. You may not download, install, or copy the Software except in the practice of using the Web 
Software with a Web browser, and only for the purposes of scheduling parent/teacher conferences. 

Restrictions  
The Software and any copies that exist are owned by Licensor.  The Software is confidential and copyrighted.  The structure of 
the Software, its organization and code are the valuable trade secrets of Licensor. Title to Software and all associated intellectual 
property rights, including but not limited to trade secrets, trademarks, service marks, patents, and copyrights are retained by and 
will remain the property of Licensor. The Software is also protected by the United States Copyright Law and International Treaty 
provisions. You must treat the Software just as you would any other copyrighted material, such as a book.  

You may not reverse engineer, decompile, disassemble or otherwise attempt to discover the source code of the Software, in 
whole or in part. You may not prepare derivative works based on the Software or its screen displays.  

No part of the Software may be reproduced, copied, or republished, in any form, without written permission from Licensor.  

Disclaimer of Warranties  
The Software and the information contained or accessed are provided "AS IS". To the maximum extent permitted by applicable 
law, Licensor and School expressly disclaim and you hereby expressly waive all warranties, conditions or representations, either 
express or implied, including but not limited to, implied warranty of merchantability, satisfactory quality, fitness for a particular 
purpose, title, non-infringement, and error-free or uninterrupted service with regard to the Software, and the provision of or 
failure to provide support services.  

To the maximum extent permitted by applicable law, in no event shall Licensor, its suppliers, or the School be liable for any 
special, incidental, indirect, consequential or punitive damages whatsoever (including, without limitation, damages for loss of 
revenue, profit or data, business interruption, loss of business information, or any other pecuniary loss), however caused, arising 
out of or related to the use of or inability to use the Software or the provision of or failure to provide support services, even if 
Licensor or School have been advised of the possibility of such damages.   

mailto:sales@VirtualParagon.com

